SIEMENS

SIMATIC

Process Control System PCS 7
PCS 7 Readme V9.0 including SP1
(online)

Readme

Version: 2018-09-24 (Online)

V9.0 SP1

A5E42605758-AC

Security information 1
Overview 2
Notes on installation 3
Notes on usage 4
Software components in

SIMATIC PCS 7 V9.0 incl. 5
SP1

Change history PCS 7 6

Readme (online)




Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

A\ DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

A\ WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

A\ CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property
damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding
potential hazards when working with these products/systems.

Proper use of Siemens products

Trademarks

Note the following:

A\ WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended or
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described.
Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG A5E42605758-AC Copyright © Siemens AG 2018.
Division Process Industries and Drives ® 10/2018 Subject to change All rights reserved
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Security information

Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is
necessary to implement — and continuously maintain — a holistic, state-of-the-art industrial
security concept. Siemens’ products and solutions constitute one element of such a concept.

Customers are responsible for preventing unauthorized access to their plants, systems,
machines and networks. Such systems, machines and components should only be connected
to an enterprise network or the internet if and to the extent such a connection is necessary
and only when appropriate security measures (e.qg. firewalls and/or network segmentation) are
in place.

For additional information on industrial security measures that may be implemented, please
visit

https://www.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them more secure.
Siemens strongly recommends that product updates are applied as soon as they are available
and that the latest product versions are used. Use of product versions that are no longer

supported, and failure to apply the latest updates may increase customer’s exposure to cyber
threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS
Feed under
https://www.siemens.com/industrialsecurity.

PCS 7 Readme V9.0 including SP1 (online)
Readme, V9.0 SP1, A5E42605758-AC 7



Security information

PCS 7 Readme V9.0 including SP1 (online)
8 Readme, V9.0 SP1, A5E42605758-AC



Overview 2

Note

Read these notes carefully. They contain important information and additional details about
SIMATIC PCS 7.

The information given in this Readme file takes precedence over all the SIMATIC PCS 7
manuals.

You have received version V9.0 incl. SP1 of the SIMATIC PCS 7 software.

SIMATIC PCS 7 is the future-oriented process control system used in the "Totally Integrated
Automation" concept by Siemens.

® Based on robust, industrial standard SIMATIC hardware and software components
® Modern, distributed system architecture

® Simple and quick system expansion and optimization in runtime

® Scalable from a small laboratory system to networks of plants

® For all applications: continuous and batch applications

e For all industries: process, production and hybrid sectors

e Efficient, plant-wide engineering

® Flexible and simple integration of field devices and drives based on PROFINET, PROFIBUS
or Foundation Fieldbus

e Homogeneously integrated safety technology, certified by the TUV (German Technical
Inspectorate)

® Support for open source interfaces based on international standards such as OPC
® Increased availability through redundancy at all levels

® Modular structured and scalable batch system, SIMATIC BATCH

® Flexible route control system, SIMATIC Route Control

® Conformity with EU GMP Guideline Annex 11 and 21 CFR Part 11

We hope that you enjoy using SIMATIC PCS 7 and have great success with it.

Your PCS 7 team

PCS 7 Readme V9.0 including SP1 (online)
Readme, V9.0 SP1, A5E42605758-AC 9
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Notes on installation

3.1

General information

Information on SIMATIC PCS 7 on the Internet

All product and order information regarding SIMATIC PCS 7:

® [nternet link (https://www.siemens.com/PCS7)

Overview of the most important technical information and solutions for SIMATIC PCS 7 in the
Industry Online Support:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/63481413)

All information on Support and Service in the Industry Online Support:

® Internet link (https://support.industry.siemens.com/My/ww/en/notifications)
Here, you can also subscribe to the newsletter, which keeps you constantly up-to-date with
current information about our products.

Content of the SIMATIC PCS 7 Readme file

The PCS 7 Readme for SIMATIC PCS 7 V9.0 incl. SP1 is available in two versions:

1. PCS 7 Readme (offline)
This is the version that is installed during the PCS 7 setup.
This file only contains general notes and links to documents on the internet.

2. PCS 7 Readme (online)
This is the version which contains all information on the installation and use of SIMATIC
PCS 7 in the format you are already familiar with.
This file is now only available on the internet so that we can keep it up to date.
You can find the current version of this document for download under the entry ID
109750097 in the Industry Online Support:

— Internet link (https://support.industry.siemens.com/cs/ww/en/view/109750097)

Note

Before you install or use SIMATIC PCS 7 V9.0 incl. SP1, itis vital that you read the information
from the most recent version of this document.

Each of the products comes with product-specific information in the form of readme files.

The information contained in these readme files also applies to using products in SIMATIC
PCS 7.

PCS 7 Readme V9.0 including SP1 (online)
Readme, V9.0 SP1, A5E42605758-AC 11
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Notes on installation

3.1 General information

Electronic manuals and help system on SIMATIC PCS 7

Pre-installed manuals

Once you have installed PCS 7 on your computer, the following PCS 7 documentation is
immediately available:

® You can find this documentation in the section Siemens Automation > Documentation or
the product information in the Start menu of Windows:

— PCS 7 - Catalog Overview (PDF)

— PCS 7 - Operating Instructions - OS Process Control (PDF)
— PCS 7 - Installation Manual - PC Configuration (PDF)

— PCS 7 - Configuration Manual - Engineering System (PDF)
— PCS 7 - Configuration Manual - Operator Station (PDF)

® The documents can also be displayed with the PUD Manager. The PUD Manager can be
opened with the link “PUDManager Helpviewer” that is located on the desktop or in the area
Siemens Automation > PUDMANAGER in the Start menu of Windows.

You can also access this documentation at any time on the SIMATIC PCS 7 DVD 1/2 in the
folder "_Manuals\English" or "_Product_Information\English".
Complete documentation for SIMATIC PCS 7 on the Internet and document updates

The complete SIMATIC PCS 7 documentation is available in multiple languages at the
following Internet site:

e [nternet link (https://www.siemens.com/pcs7-documentation)

You also have the option of updating the installed PCS 7 help system installing the PCS 7
system documentation later. The "PCS 7 Documentation Portal Setup" required for this is
available for download under the entry ID 109744320 in the Industry Online Support:

® Download link (https://support.industry.siemens.com/cs/ww/en/view/109744320)

Note
Timeliness of online documents
Documents available online may be more up-to-date than the version of documents installed

with PCS 7 Setup. The statements in documents available online should therefore be given
priority over installed documents.

Information on modified documents
In order to keep yourself informed about changes to the PCS 7 readme and other PCS 7

documentation, we recommend activating the relevant notification in the Industry Online
Support:

e [nternet link (https://support.industry.siemens.com/My/ww/en/notifications)

PCS 7 Readme V9.0 including SP1 (online)
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Noftes on installation

3.2 Type of delivery

3.2 Type of delivery

3.2.1 Delivery package

The products listed in the table below are delivered with the installation media required for the
respective product:

e SIMATIC PCS 7 V9.0 incl. SP1 Software Media Package:
2 DVDs PCS 7 V9.0 incl. SP1 in a jewel case or as software download
1 CD SIMIT Simulation Framework V9.1 in a jewel case or as software download
1 CD S7 F-Systems V6.2 Update 1 in a jewel case or as software download
1 CD Safety Matrix V6.2 SP2 Update 2 in a jewel case or as software download
Certificate of License

or

e SIMATIC PCS 7 V9.0 incl. SP1 Software Media Package ASIA:
2 DVDs PCS 7 V9.0 incl. SP1 in a jewel case
1 CD S7 F-Systems V6.2 Update 1 in a jewel case
1 CD Safety Matrix V6.2 SP2 Update 2 in a jewel case
Certificate of License

The license keys required to operate the software for the supplied product are located on the
License Key memory stick.

To simplify your license management, you can also save the license keys for other SIMATIC
PCS 7 products on this memory stick. Authorizations for older SIMATIC products must be
saved on authorization disks.

3.2.2 Licensed commissioning of SIMATIC PCS 7 V9.0 incl. SP1 ASIA

You will receive the SIMATIC PCS 7 V9.0 incl. SP1 ASIA license keys on a License Key USB
Hardlock as the license storage medium.

Use the Automation License Manager to transfer the licenses to the SIMATIC
PCS 7 V9.0 incl. SP1 ASIA PC during installation or afterwards.

Note the following when handling the license storage medium:
® Do not delete any files from the License Key USB Hardlock.
® Do not copy any data to the License Key USB Hardlock.

® Do not format the License Key USB Hardlock.

® Do not remove the License Key USB Hardlock from the computer while PCS 7 is running.

NOTICE

Demo mode

SIMATIC PCS 7 OS will change to demo mode when you remove the License Key USB
Hardlock from the computer.

PCS 7 Readme V9.0 including SP1 (online)
Readme, V9.0 SP1, A5E42605758-AC 13



Notes on installation

3.2 Type of delivery

3.2.3

3.24

14

SIMATIC PCS 7 Trial Mode

The software functions and configuration limits which are activated as part of the 14-day trial
mode are not authorized for productive use.

SIMATIC PCS 7 trial mode is characterized by the following features:

PCS 7 trial mode can be activated via the PCS 7 system setup or after the first start, and
used for up to 14 calendar days in non-productive operation.
After 14 days, it can no longer be used.

The maximum capacity in Engineering and Runtime is 250 process objects. Please note
that the "System blocks" in the PCS 7 trial mode are added to the limit count (for example,
OB BEGIN, etc.). These "System blocks" are not displayed in the CFC process object
statistics.

OS Runtime operation including SFC visualization is possible on a single station (no client
server, no web server, no redundancy).

SIMATIC BATCH can be used with up to 10 units.
The BATCH API cannot be used in trial mode.
SIMATIC Route Control can be used for up to 30 routes.

All other PCS 7 functions/configurations/capabilities (for example Import/Export Wizard,
Client server, more than 250 PO) are not available in the PCS 7 trial mode.

After installing the licenses for productive operation (see the catalog ST PCS 7), the PCS
7 trial mode can also be installed for indefinite productive operation with a scope of functions
corresponding to the license that was purchased and installed.

Notes on the license contract for the SQL server

Note that SIMATIC PCS 7 also includes the SQL Server software licensed by Microsoft
Corporation. With the use of SIMATIC PCS 7, you agree to be bound by and to abide by the
attached Microsoft terms and conditions for end customers for the Microsoft SQL Server.

The Microsoft "SQL Server" supplied with PCS 7 may not be used outside the PCS 7
environment without prior written consent from Siemens.

PCS 7 Readme V9.0 including SP1 (online)
Readme, V9.0 SP1, A5E42605758-AC



Noftes on installation

3.3

3.3.1 PC hardware

3.3.1.1

Hardware requirements

Recommended PC hardware configuration

Recommended basic hardware configuration

3.3 Hardware requirements

We recommend the following configuration for PC components (the higher the quality of the
equipment, the better):

Parameters

Central Engineering Station with server oper-
ating system, Process Historian', Information
Server,

PCS 7 OS / SIMATIC BATCH / SIMATIC
Route Control on a PC,

Engineering station,
OS server,

OS single station,
Maintenance Station,

PCS 7 Web server, OS client, and BATCH
client on a PC,

BATCH server,

BATCH single station,

Route Control server,

Route Control single station
SIMATIC Management Console

OS client,
BATCH client,
Route Control client

Basic PC (see catalog)

SIMATIC IPC 847C / 847D / 647C / 647D /

SIMATICIPC847C /847D /647C/647D/

Partition size

C:\ 100 - 128 GB

547D | 547E | 547G 547D | 547E | 547G
Processor Min. INTEL Core 2 Duo; >=2.4GHz, INTEL Core 2 Quad
Work memory (RAM) >=8 GB (64-bit operating system) >=4 GB (64-bit operating system)
Hard disk >=200 GB HDD/SSD >=160 GB HDD/SSD

C:\ 100 - 128 GB

Network adapter /
Communications interfaces

® For terminal bus
communication

® For plant bus communication

® RJ45 on-board gigabit Ethernet
e CP 1623 or BCE network adapter

® RJ45 on-board gigabit Ethernet

Opt. drive

DVD

DVD

PCS 7 Readme V9.0 including SP1 (online)
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Notes on installation

3.3 Hardware requirements

Parameters

OS client

Basic PC (see catalog)

IPC427D / IPC477D

IPC427E / IPC4A77E

Processor Intel Core i7-3517UE Core i5-6442EQ
Work memory (RAM) >=4.0 GB >=4.0 GB
Hard disk >=160 GB HDD/SSD

Partition size

C:\ 100 GB - 128 GB

Network adapter/communica-
tions interfaces

2 x RJ45 on-board Gigabit Ethernet
without PROFINET or PROFIBUS interface

Purpose Approved for OS/Batch client operation only
We recommend the following configuration for Box / Microbox components (the higher the
quality of the equipment, the better):
Parameters SIMATIC IPC627C / IPC677C / IPC627D / SIMATIC IPC427C / IPC427D
IPC677D
Processor min. Intel Core i7-610E Prozessor Intel Core2 Duo / Intel Core i7-3517UE
Clock-pulse rate 2.53 GHz >=1.2 GHz
Work memory (RAM) 4 GB (32-bit operating system) 20-40GB

>= 8 GB (64-bit operating system)

Hard disk
Partition size

>=200 GB HDD / SSD
C:\ 100 - 128 GB

Compact Flash card: 8.0 GB / SSD: 80
GB

Network adapter/communica-
tions interfaces

® 2 x RJ45 on-board Gigabit Ethernet
e onBoard PROFIBUS CP 5611/ CP 5622
® onBoard PROFINET CP 1616

e (CP 1623 or BCE network adapter (BCE
also via onBoard Gigabit Ethernet)

e 2 x RJ45 on-board Gigabit Ethernet

e onBoard PROFIBUS CP 5611/
CP 5622

e onBoard PROFINET CP 1616

Opt. drive

DVD

Purpose

SIMATIC IPC627C / IPC677C / IPC627D /
IPC677D (BOX PC) is released as part of the
PCS 7 BOX systems.

PCS 7 AS RTX based on SIMATIC
IPC427C / IPC427D only released for AS
operation.

Note

Please note the following:

® In the case of multi-user engineering, it is beneficial for the engineering stations if you use
PCs with high clock-pulse rates, large main memories and hard disks, and high-speed disk
drives. In addition to the Microsoft recommendation of "15% free space", we recommend
that you reserve at least 2 GB of free space (depending on the size of the project) on the
system partition.

e ) When using Process Historian, also read the notes in the "Hardware requirements"
section in the Process Historian 2014 SP3 installation manual.

® In the case of multi-VGA configurations with extensive graphical engineering, a CPU clock
frequency that is as high as possible is recommended. In these cases deactivating Hyper-
Threading in the BIOS of the OS Client can result in increased performance of the graphics

output.
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Additional information
e (Catalog ST PCS 7 for V9.0 incl. SP1

® Add-on catalog ST PCS 7 for V9.0 incl. SP1

3.3.1.2

3.3 Hardware requirements

Compatibility matrix SIMATIC IPC and accessories for PCS 7 V9.0 incl. SP1

Compatibility matrix SIMATIC IPC and accessories for PCS 7 V9.0 incl. SP1

PCS 7 V9.0 incl. SP1 | Article no. Windows | Windows | Windows | Windows | Windows | Windows
Embed- 7 7 10 Server Server
ded Ultimate / | Ultimate / | Enterprise | 2912 R2 2016
Standard | Enterprise | Enterprise 2015 Standard | Standard

2009 |32-BitSP1|64-BitsP1| LTSB Edition Edition
32-Bit 64-Bit 64-Bit 64-Bit

RACK IPC

IPC547D 6ES7 660-3....-.... - - X - - -

IPC547E 6ES7 660-4....-.... - - X - X -

IPC547G 6ES7 660-7....-.... - - X X X X

IPC647C 6ES7 660-1....-.... - - X - - -

IPC647D 6ES7 660-5....-.... - - X X X X

IPC847C 6ES7 660-2....-.... - - X - - -

IPC847D 6ES7 660-6....-.... - - X X X X

BOXIPC

IPC627C, IPC677C B6ES7 650-4A...-.... - X - - - -

BOX with/without RTX

2010

IPC627D, IPC677D 6ES7 650-4B...-.... - X! x? x? - -

BOX with/without RTX

2010

Microbox

IPC427C, AS RTX B6ES7 654-0UE13-0XX X - - - - -

(RTX 2010) 0

IPC427D, AS RTX 6ES7 - X - - - -

PROFIBUS (RTX 654-0UE23-0XX1

2010)

IPC427D, AS RTX 6ES7 - X - - - -

PROFINET (RTX 654-0UE23-0XX2

2010)

IPC427D, IPC477D 6ES7 650-0UG..-.... - - X - - -

OS clients

IPC427E, IPCA77E 6ES7 650-0VG..-.... - - - X - -

OS clients
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PCS 7 V9.0 incl. SP1 | Article no. Windows | Windows | Windows | Windows | Windows | Windows
Embed- 7 7 10 Server Server
ded Ultimate / | Ultimate / | Enterprise | 2012 R2 2016
Standard | Enterprise | Enterprise | 2015 Standard | Standard
2009 |32-BitSP1|64-BitsP1| LTSB Edition Edition
32-Bit 64-Bit 64-Bit 64-Bit
CPs
CP 1613 A2 6GK1 161-3AA01 - X X - - -
CP 1623 6GK1 162-3AA00 - X X X X X
CP 1628 6GK1 162-8AA00 - - X X X X
Accessories
Intel Gigabit CT desk- | A5E02639550 - X X X X X
top adapter (EX-
PI19301CT)
Multi monitor card X2 | 6ES7 652-0XX04-1XE - X X X X -
(M series) PCle 0
Multi monitor card X4 | 6ES7 652-0XX04-1XE - X X X X -
(M series) PCle 1
NVidia NVS315 A5E36966175 - - X X X X
SIMATIC PCS 7 USB | BES7 652-0XX02-1XC - X3 x3 x3 x3 x3
smart card reader 0
(OK3121)
TCOS 2.0 smart cards | 6ES7652-0XX05-1XD - - - - - -
1
TCOS 3.0 smart cards | 6ES7652-0XX00-1XD - X X X X X
2
Signal module, PCI 6DS1 916-8RR - X X X X -
card for installation in
an operator station

Legend for the table:
"-" = incompatible
"X" = compatible
Footnotes:

" With WinAC RTX

2 Without WinAC RTX
3 With SIMATIC Logon

3.3.1.3

Network

Network configuration

The network for the PCS 7 systems must be isolated via switches, routers or gateways in such
a way that no external interference can affect the PCS 7 network.
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3.3 Hardware requirements

You can find recommendations for this in the document:
® PCS 7 Security Concept PCS 7 & WInCC (Basic)

The document is available for download under the Entry ID 60119725 in the Industry Online
Support:

e Download link (https://support.industry.siemens.com/cs/ww/en/view/60119725)

3.3.2 AS hardware

Documentation on hardware

The versions of the AS hardware components that are approved for PCS 7 V9.0 incl. SP1 are
described in the manual "PCS 7 - Released Modules". You can find this document on the
website for SIMATIC PCS 7 Technical Documentation (www.siemens.com/pcs7-
documentation).

Time synchronization
We generally recommend the use of a central system clock.

You can find notes on SICLOCK TC 100/ TC 400 in the "PCS 7 — Time synchronization"
function manual. You can find this document on the website for SIMATIC PCS 7 Technical
Documentation.

® [nternet link (www.siemens.com/pcs7-documentation)

You can find additional information on SICLOCK products under entry ID 67638218 in the
Industry Online Support:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/67638218)

We have tested the compatibility of products from the BURK MOBATIME GmbH company with
regard to time synchronization.

You can find notes on time synchronization with BURK MOBATIME GmbH products under
entry ID 109760344 in the Industry Online Support:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/109760344)

When using the internal Ethernet/PROFINET interface, the CPUs 6ES7414-3EM05-0ABO,
6ES7414-3EM06-0ABO, 6ES7414-3EM07-0ABO, 6ES7416-3ER05-0ABO,
6ES7416-3ES06-0AB0 und 6ES7416-3ES07-0ABO can only be synchronized with the NTP
method. For the previous CPU types, we continue to recommend that you use the SIMATIC
method.
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3.4 Installation of the software, software requirements
3.4.1 Software installation
3.4.1.1 Requirements

Released operating systems

The following operating systems are supported in PCS 7 V9.0 incl. SP1 :

Windows 7 Professional SP1 (64-Bit, only English Windows language version)
Windows 7 Ultimate / Enterprise SP1 (32-Bit)

Windows 7 Ultimate / Enterprise SP1 (64-Bit)

Windows 10 Enterprise 2015 LTSB (64-Bit)

Windows Server 2012 R2 Standard Edition (64-Bit) (as "Windows Server 2012 R2 Standard
with Update" or incl. KB 2919355 ,Windows Server 2012 R2 Update®)

Windows Server 2016 Standard Edition (64-Bit)

Note
Use of Windows 10 Enterprise 2015 LTSB 64-bit

1.

When you use two network adapters, one of which was configured with and one without

default gateway address, the following problem can occur:

— The Ethernet card without default gateway address can stop trying to establish a
connection to a communication partner over IP protocol after multiple unsuccessful
attempts (when the communication partner cannot be reached temporarily).

— The communication partner cannot be reached in this case until the ARP cache has
been reset.

The solution is to install at least the cumulative update for Windows 10 (KB3156387):

Windows 10 (1507) is the basis for the Windows 10 Enterprise 2015 LTSB.

You can check which cumulative update is currently available for download for this Windows

10 version at the following Microsoft website:

— Internet link (https://support.microsoft.com/en-us/help/4000823)

Please check to make sure that the most current cumulative update for this Windows 10
version is compatible with PCS 7.

— Internet link (https://support.industry.siemens.com/cs/ww/en/view/18490004)
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Note
Installation / upgrading to PCS 7 V9.0 incl. SP1
Before you start with the installation/upgrading of your computers to PCS 7 V9.0 incl. SP1,

ensure that the currently released MS patches for the respective operating system are installed
on the computers.

For information about the handling of current Microsoft security patches in PCS 7 please refer
to the topic "Patch management and security updates® in this section.

Released processor architectures

Only the x64 platform is used for processor architectures which support 64-bit memory
addressing.
Systems with Intel Itanium CPU architecture (IA64) are not supported.

Compatibility list PCS 7 PC configurations and operating systems

Not all configurations are suitable for every operating system. The following table shows the
relationship of the most common configurations of PCS 7 to the operating systems.

Before performing the installation, refer to the product-specific readme files to ensure that the
product being installed is suitable for the desired operating system.

Windows | Windows 7 | Windows 7 | Windows 7 | Windows Windows Windows

Embedded | professio- | Ultimate/ | Ultimate / 10 Server Server

Standard nal SP1 Enterprise | Enterprise | Enterprise 2012 R2 2016

2009 64-Bit SP1 SP1 2015LTSB | Standard | Standard
32-Bit (only Eng- 32-Bit 64-Bit 64-Bit Edition Edition
lish) 64-Bit 2 64-Bit

ES - X - X X X X
OS Single Station - X2 - X X X X
ES/OS Single Station - X2 - X X X X
OS Server - - - - - X X
OS Client - X - X X X X
Web Server - - - X! X! X X
Web Client - X - X X X X
Process Historian - - - - - X X
Information Server - - - X X X X
SIMATIC Management - - - - - X X
Console
SIMATIC Batch Single - - - X X X X
Station
SIMATIC Batch Client - - - X X X X
SIMATIC Batch Server - - - - - X X
SIMATIC Route Control - - - - - X X
Server
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Windows | Windows 7 | Windows 7 | Windows 7 | Windows Windows Windows
Embedded | professio- | Ultimate/ | Ultimate / 10 Server Server
Standard nal SP1 Enterprise | Enterprise | Enterprise 2012 R2 2016
2009 64-Bit SP1 SP1 2015LTSB | Standard | Standard
32-Bit (only Eng- 32-Bit 64-Bit 64-Bit Edition Edition
lish) 64-Bit 2 64-Bit
SIMATIC Route Control - - - X X X X
Client
OpenPCS 7 Stand-alone - - - X X - _
OpenPCS 7 with OS Cli- - - - X X - -
ent
OpenPCS 7 with OS - - - - - X X
Server
OpenPCS 7 with OS Sin- - - - X X - _
gle Station
PCS 7 BOX - - - X X - -
PCS 7 BOX RTX - - X - - - -
OS Client Microbox - - - X X - -
PCS 7 AS mEC RTX X - - - - - -
PCS 7 AS RTX X - X - - - -
Legend for the table:
"-" = incompatible

"X" = compatible
Footnotes:

" Only on ES or OS single-station system (only on OS single-station with Windows 10)

2 Non-redundant

3 Only in the version "Windows Server 2012 R2 Standard with Update" or with KB 2919355 ,Windows Server 2012 R2 Update”

Note

Released operating systems

The specifications of released operating systems made in this Readme take precedence over
any other contradictory specifications made in the Readme files of the individual products.

Microsoft Internet Explorer

Only Internet Explorer 11 is permitted.

e |nternet link (https://windows.microsoft.com/en-US/internet-explorer/ie-11-worldwide-
languages)

Note:

Internet Explorer 11 attempts to automatically install the required Microsoft Patches (KB)
during the installation. If this installation fails, for example because no Internet connection can
be made, the installation procedure is aborted. In this case, you need to install the required
KBs manually before you can install Internet Explorer 11.

e |nternet link (https://support.microsoft.com/kb/2872074)
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Microsoft .NET Framework

The Microsoft .NET Framework feature must be enabled prior to the installation of the PCS 7
software.

Windows 7

Control Panel -> Programs and Features -> Turn Windows features on or off

Windows 10 and Windows Server 2012 R2 or Windows Server 2016

Read the information from Microsoft:

e [nternet link (https://msdn.microsoft.com/en-us/library/hh506443(v=vs.110).aspx)

If you enable the ".NET Framework" feature without an Internet connection, you can use the
Windows installation medium as the file source:

1. Insert the Windows installation medium.

2. Run the following command in the command prompt with higher-level rights:
Dism.exe /online /enable-feature /featurename.:NetFx3 /All /Source.<DVD drive letter>:
Isourceslsxs /LimitAccess

PCS 7 system setup

Other required parts of the Microsoft .NET Framework are automatically installed with the
PCS 7 system setup.

Microsoft SQL Server

Microsoft SQL Server 2014 SP2 is installed automatically by the PCS 7 system setup. The
computer name must be set before SQL Server is installed. The computer name may not be
changed afterwards.

Notes on installing the operating system

Before installing PCS 7, you must install an operating system released for the planned PCS 7
configuration.

The use of tools such as Windows Easy Transfer to transfer data and settings between different
operating systems or to perform a direct upgrade from a previous operating system (e.g. from
Windows 7 to Windows 10) has not been approved.

The use of the following operating system features has not been approved for PCS 7:
e XP mode (only available with Windows 7)

® HomeGroup (only available with Windows 7 and Windows 10)

e Parental Control (only available with Windows 7 and Windows 10)

e Windows Defender

e BitLocker

e Fast User Switching (The use of this feature can be disabled by the administrator via a
group policy. You can find additional information on the procedure on the SIMATIC PCS 7
DVD 1/2 in the folder _Manuals\English "PCS 7 - PC Configuration.pdf" in the section "How
to disable user switching").
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Windows Software Update Service (WSUS)

The WSUS cannot install software versions that are not described in this document as a
minimum system requirements. This includes service packs for Microsoft operating systems,
SQL Server, Office or new versions of Internet Explorer.

This guideline does not apply to the mentioned patch classifications published under entry ID
18490004:

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/18490004)

You need to operate the WSUS at least on the basis of Windows Server 2012 R2 for patch
management of plant computers using the Windows 10 and Windows Server 2012 R2 or
Windows Server 2016 operating systems.

Also read the information from Microsoft for setting up the WSUS:

® [nternet link (https://docs.microsoft.com/en-us/windows/deployment/update/waas-
manage-updates-wsus)

Patch management and security updates

24

You can find information on the use of the latest Microsoft security patches in the Industry
Online Support under entry ID 18490004

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/18490004)

To ensure secure and stable operation of the operating system and therefore PCS 7, we
recommend the installation of the mentioned updates.

Note

Configuration for automatic updates with Windows 10 and Windows Server 2012 R2 or
Windows Server 2016

The "Patch management" section of the configuration manual "PCS 7 Compendium Part F -
Industrial Security" (https://support.industry.siemens.com/cs/ww/en/view/109756871)
describes the recommended PCS 7 settings for automatic updates.

If these settings are enabled, the user is notified about available updates by the Windows
operating system.

Result:

The operator has access to the operating system level of the local PCS 7 Operator Station
(OS) despite enabled keylock.

Remedy:
e Disable the "Configuring automatic updates" policy described in the manual.

Consequence of the disable:

® Updates are only downloaded and made available for installation on the respective
computer with a manual request by an administrator through a Windows update.
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Additional information on the topic of industrial security and plant security

You can find additional documents and information on the topic of industrial security and plant
security in the Industry Online Support, in the "All-round protection with Industrial Security -
Plant Security" entry list and the "PCS 7 Compendium Part F - Industrial Security" document:

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/50203404)

Permitted domain controllers (DC)
® Domain Controller (DC) based on Windows Server 2012 R2 (Standard edition).

Operating system languages

When you use PCS 7, you will have to set the required language and region at every point in
the Windows language settings. This affects all the settings available under “Region and
Language”.

If you use PCS 7 ASIA, make the following settings in the Windows regional and language
options:

e Select"Chinese (PRC)" for "Language for non-Unicode programs". You need to make these
settings before installing the PCS 7 software.

® For the "Display language", select "English (USA)" if you have set the language of the
PCS 7 user interfaces to English.

® Forthe "Display language", select "English (USA)" or "Chinese (Simplified)" if you have set
the language of the PCS 7 user interfaces to Chinese.

® Forthe "Format", select "Chinese (PRC)".
Then copy these settings for the following accounts:
® \Welcome page and system accounts

® New user accounts

Rules for computer names
The selection of the computer name is critical for the entire project configuration:

® |llegal characters: ., ;:!1?2"'" A" "~-+=/\1@*#3$ % &§°()[]1{} <> space, hyphen
("-"), underscore ("_"

® Max. 15 characters

® Uppercase letters only

® The first character must be a letter.

It is always advisable that only alphanumeric characters are used for the computer name. You
should choose a name consisting of uppercase Latin letters (A-Z) and digits (0-9) only, starting
with a letter and containing a maximum of 15 characters.

Before installing the PCS 7 software

® Message queuing must be enabled for PCS 7.
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Security settings
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When required, the following Microsoft Patches are installed automatically by the PCS 7
system setup depending on the installed operating system and type of installation:

e KB2905569 for 64-bit operating systems (the PCS 7 system setup may prompt you to restart
the computer for installation of this Microsoft patch)

e KB2516889 for Windows 7

o KB2554746 for Windows 7 (the PCS 7 system setup may prompt you to restart the computer
for installation of this Microsoft patch)

You can find information about the security settings in the "_Manuals\English" folder, "PCS 7
- PCS 7 PC Configuration.pdf' document on the SIMATIC PCS 7 DVD 1/2 in the sections
"Security settings for the PC configuration" and "Firewall".

Settings need to be made in the registry, the DCOM configuration and the exception list of the
Windows firewall for the PCS 7 software to operate correctly.

These settings are made during the installation of PCS 7 (system setup) by the "Security
Controller" application. The "Setup - System Settings" dialog appears before the installation
begins. There, the system settings to be changed are listed. To continue the setup, you need
to agree to the change to these system settings.

Note

Please note the following:

® The settings must be applied again if the work environment changes (domain, workgroups).
You can open the Security Controller with the menu command:

— Windows 7: Start > Programs > Siemens Automation > Security Controller > Repeat
Settings.

— Windows 10: Start > All Apps > Siemens Automation > Security Controller > Repeat
Settings.

— Windows Server 2012 R2: Start > Apps > Siemens Automation > Security Controller >
Repeat Settings.

— Windows Server 2016: Start > Siemens Automation > Security Controller > Repeat
Settings.

e Start the Security Controller after the PC has been added to the domain and rebooted.
Remember that the Windows services that are required for the Security Controller are not
immediately available after Windows logon. If the tool is started without entries,restart it
after a brief interval.

® The settings in the exception list of the Windows firewall are applied to the area of the local
network (subnet). If your PC stations are located in different networks (subnets), you need
to change this area manually and make this change again after each execution of the
"Security Controller".

e |f you need to make local Windows firewall settings that differ, they should be adapted
afterwards.

® The settings in the exception list of the Windows firewall are made when the Windows
firewall is disabled.
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OPC XML DA
OPC XML DA has not been released.

Setting the permissions for restarting the system

When using Windows Server operating systems, users without administrator rights must be
provided authorization for "System Shutdown".

Without these rights, the system cannot be restarted.

As an administrator, you can set the permission for other user groups using a group policy as
follows:

1. Use [Windows button]+[R] to launch the "gpedit.msc" file.

2. Open the following path in the group policies editor:
Computer Configuration > Windows Settings > Security Settings > Local Policies > User
Rights Assignment.

3. Add the required user groups for the "System Shutdown" object.

Notes on installing the software over a network

To be able to install on multiple computers at the same time, you need to make the contents
of the two SIMATIC PCS 7 DVDs available in one storage location (shared network path).

The following rules apply to the storage:

® The folders must be called "DVD_1" and "DVD_2" and must be located within a shared
folder (see example).

® The name of the access path to the network copy of the DVDs (including the folder "DVD_1"
or "DVD_2") cannot contain more than 85 characters.

Example:

Create a network copy of the two SIMATIC PCS 7 DVDs with the following structure:

e __\PCS7_Vxx\
- DVD_1MN\
- DVD_2\

Use of additional software for creating and viewing PDF documents

The PDF-XChange 6.0 software for creating and viewing PDF documents has been tested
with PCS 7 V9.0 incl. SP1 for compatibility and can be installed subsequently.
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3.4.1.2 Notes on installing the software

New installation

Steady state

There are two possible ways to install PCS 7:

1. Installation of a previously backed up image of the operating system.
This image cannot contain a PCS 7 installation.
You can then install PCS 7 on this image.

2. New installation of the operating system followed by new installation of PCS 7.

You can find detailed information about the installation requirements and procedure in the
"PCS 7 PC Configuration.pdf" document in the "_Manuals\English" folder on the SIMATIC
PCS 7 DVD 1/2.

During the installation of the PCS 7 software, the system must be in steady state:

Make sure that no updates are being performed for antivirus software or the Windows Software
Update Services (WSUS) during the installation. You can ensure this by temporarily disabling
the corresponding options in each program.

Installation on computers with multi-core processor

When you install the PCS 7 software on PC hardware with multi-core processors in which the
number of processors does not equal 2", or when you use NUMA (Non Uniform Memory
Access), you must follow the instructions under entry ID 59703368:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/59703368)

PC hardware based on SIMATIC IPC recommended for PCS 7 is not affected by this.

Installation via network

When performing a network installation of PCS 7, ensure that access to the setup procedure
is guaranteed, even if the computer reboots during the PCS 7 Setup. If the computer is not in
a domain, you must enter the logon information of the user in order to access the network
share for the server in the Windows Credential Manager.

Installation on an Asian system

28

When creating and using setup packages for the installation of SIMATIC software, it is
mandatory to input English characters for some entries.

If you wish to use setup packages, always input English characters for the following entries
(Asian characters are not permitted):

® Name of the software or the software package

® Name of the required, shared storage location

PCS 7 Readme V9.0 including SP1 (online)
Readme, V9.0 SP1, A5E42605758-AC


https://support.industry.siemens.com/cs/ww/en/view/59703368

Noftes on installation

3.4 Installation of the software, software requirements

Installation of keyboard filter for 32-bit operating systems

Once the PCS 7 software has been successfully installed, you are prompted to reboot the
computer. When you subsequently log on with user or power user rights, you may see a dialog
for installing the drivers for "Keyboard_Filter_01" or "Keyboard_Filter_02". Enter the name and
password for a user with administrator rights in this dialog and confirm the dialog with "OK".

Close the Internet Explorer (IE11) before starting the installation

Before starting the PCS 7 Setup, make sure you have correctly closed IE11. Close any
processes still running (ieexplore.exe), for example, by using the Windows Task Manager.

Installation via SIMATIC Management Console

You cannot install the following products from the "Additional_Products" folder of the SIMATIC
PCS 7 DVD 2/2 using the SIMATIC Management Console:

® DiagMonitor

e MTU

® ReportBuilder3

® SAS-DC_2017_1 (Simatic Assessment Suite Data Collector 2017)
® |nformation server BATCH options

® Crystal Reports Xl for Route Control

You can find a list of all products and PCS 7 components that can be installed via the SIMATIC
Management Console under entry ID 107796665 in Industry Online Support:

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/107796665)

Installation of the SIMATIC Management Agent

The SIMATIC Management Agent is automatically installed with every installation of PCS 7 to
facilitate the integration of your computers in a plant managed with the SIMATIC Management
Console.

However, if it was not explicitly selected for installation, the associated service of the same
name is disabled.

The computer cannot be managed through the SIMATIC Management Console in this state.
To enable its active use, proceed as follows:

1. Open the Microsoft Management Console for services using Start > Run: enter
"services.msc".

2. Change the "Startup type" to "Automatic" for "SIMATIC Management Agent".
3. Start the service by pressing the "Start" button.
4. Click "OK" to close the dialog.
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Note of the documentation packages in PUD Manager Help Viewer

The installation of PCS 7 V9.0 incl. SP1 will delete documentation packages for older versions
of PCS 7 in the PUD Manager. You can find the latest documentation package for download
under entry ID 109748882 in the Industry Online Support:

e |nternet link (https://support.industry.siemens.com/cs/ww/de/view/109748882)

3.41.3 Notes on updating the software

Updating PCS 7 projects

When updating the software, read the manuals "Software Updates Without Utilization of New
Functions" or "Software Updates With Utilization of New Functions". You can find both of these
documents on the website for SIMATIC PCS 7 Technical Documentation:

® [nternet link (www.siemens.com/pcs7-documentation)

Updating the PCS 7 Software

Computer reboot

If you use the "Update" function in the PCS 7 setup, we recommend you reboot the PC before
performing the installation.

During the software update, there may be some instances when a message appears prompting
you to reboot your PC. Reboot the PC. The installation is then automatically continued.

Updating a Process Historian system
PCS 7 V9.0 incl. SP1 contains the version "Process Historian 2014 SP3".

If you want to update the Process Historian to this version, follow the instructions in the Process
Historian readme file, section 4 "Process Historian Upgrade Installation".

You can find the "InstallNotesPRHIdeDE.pdf" file on the SIMATIC PCS 7 DVD 1/2 in the folder
"27b_PH+IS_Install_and_Release-Notes".

3.4.2 Microsoft Windows settings

General information

You can find information about the settings on the SIMATIC PCS 7 DVD 1/2 in the folder
_Manuals\English in the document "PCS 7 - PCS 7 PC Configuration.pdf".

Settings for the Microsoft Internet Information Service (IIS)

The Internet Information Service is a prerequisite for the installation and use of certain PC
stations (Web server, Information Server).
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You can learn about the settings required to configure the IIS in the documentation for the
respective product used (e.g. the Web server installation instructions). You also need to read
the information on configuration of the IS in the document "PCS 7 - PCS 7 - PC
Configuration.pdf".

343 Installation of engineering station (ES) and operator station (OS) on a single PC

If you wish to install an ES on an existing OS, it is absolutely essential to remove the installed
PCS 7 OS version first and then perform the "Engineering Station" installation.

344 Installation of SIMATIC NET products
SIMATIC NET products always have to be installed by using the system setup for PCS 7.

Possible applications for the SCALANCE S, CP 443-1 Advanced and CP 1628 security products in the
PCS 7 environment

You can learn how to use the SIMATIC security products SCALANCE S, CP 443-1 Advanced
and CP 1628 with PCS 7 from entry ID 67329379 in Industry Online Support:

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/67329379)

3.4.5 Use of the Media Redundancy Protocol (MPR) for PROFINET fieldbus

Network topologies

It is absolutely necessary to operate the PROFINET fieldbus ring with MRP (Media
Redundancy Protocol) when using rings with PROFINET. The media redundancy protocols
HRP (High Speed Redundancy Protocol) and MRP cannot be used simultaneously in the same
ring. The PROFINET fieldbus ring may only consist of devices that support MRP functionality.

HRP MRP

High Speed Redundancy | Media Redundancy

Protocol Protocol
Separate terminal and plant bus X -
Common terminal and plant bus X -
PROFINET fieldbus - X

Configuration of the watchdog time

In the event of a transmission line failure, reconfiguration of the network (switching to the
redundant transmission line) can take up to 200 ms.
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Increase the watchdog time for each station by:

Selecting the "Fixed update time" setting

Increasing the update time to a value that is smaller than the fastest update of the process
image partition (PIP) for this station

Increasing the number of accepted update cycles with missing I/O data, so that the
watchdog time is > 200 ms

See also Entry ID 46636225

Internet link (https://support.industry.siemens.com/cs/ww/en/view/46636225)

3.4.6 Settings for standard network adapters (BCE and Softnet)

3.4.6.1 Plant bus with TCP/IP protocol

Make the following settings for the plant bus:

Disable "File and Printer Sharing for Microsoft Networks"
Disable "Client for Microsoft Networks"
Activate the "SIMATIC Industrial Ethernet (ISO)" log

Refer to the information in the PCS 7 Engineering System Configuration Manual, PCS 7
Operator Station Configuration Manual and the WinCC Information System: "Special aspects
of communication in a server with multiple network adapters".

3.4.6.2 BCE and time synchronization

When synchronizing the time via BCE, select the following settings:

1 - 10 sec. intervals on the external time transmitter
The ISO protocol be installed and enabled for the network adapter.
Only one network adapter (BCE) can be used for time synchronization on an OS.

Use the following multicast destination address for time synchronization with BCE:
09-00-06-01-FF-EF

Broadcast may not be used

You can find additional information on the configuration of time synchronization in a PCS 7
plant in the "PCS 7 Time Synchronization" manual.
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347 Installation of older versions of PCS 7 libraries

Post-installation of the current version

Following the installation of PCS 7 V9.0 incl. SP1, when you install or remove an older version
of the PCS 7 Library, the PCS 7 Basis Library or PCS 7 Advanced Process Library , you must
subsequently re-install the current versions of the PCS 7 Basis Library or PCS 7 Advanced
Process Library. This is necessary in order to guarantee proper functioning of the CFC driver
generator.

Downloading older versions

You can find the libraries of older PCS 7 versions available for download under entry ID
109480136 in the Industry Online Support:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/109480136)

3438 Using antivirus software and whitelisting protection mechanisms

Approved antivirus software

You can find additional documents and information on the topic of industrial security and plant
security in the Industry Online Support, in the "All-round protection with Industrial Security -
Plant Security" entry list and the "PCS 7 Compendium Part F - Industrial Security" manual:

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/50203404)

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/109756871)

The following virus scanners have been tested with PCS 7 V9.0 incl. SP1 for compatibility and
can be installed subsequently even with an existing PCS 7 installation:

® Symantec Endpoint Protection
® Trend Micro OfficeScan
e McAfee Endpoint Security

You can find the product version of the corresponding virus scanner suitable for your PCS 7
version in the regularly updated entry ID 64847781 in the Industry Online Support:

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/64847781)

Note
Restriction when using Trend Micro OfficeScan:

Trend Micro Office Scan is not released for use on PCS 7 Box RTX systems.

Behavior monitoring must be disabled when using Trend Micro V12.
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Note

The "Defender” virus scanner integrated in Windows is not approved for use with PCS 7 and
must be disabled via the group policies when the Windows 10 2015 LTSB operating system
is used.

Procedure:

e Use [Windows button]+[R] to launch the "gpedit.msc" file and open the following path in the
group policies editor:
Computer Configuration -> Administrative Templates -> Windows Components -> Windows
Defender

e Activate the "Disable Endpoint Protection" policy

Using Whitelisting protection mechanisms

3.4.9

34

Whitelisting mechanisms provide protection for the installation of PC systems by prohibiting
the execution of unauthorized software or modification of installed applications.

Additional security applications are installed to enable such protection.

The following application Whitelisting software has been tested with PCS 7 V9.0 incl. SP1 for
compatibility:

® McAfee Application Control

You can find the product version of McAfee Application Control suitable for your PCS 7 version
in the regularly updated entry ID 64847781 in the Industry Online Support:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/64847781)

You can find additional information on the "Utilization of Whitelisting with McAfee Application
Controlina PCS 7 / WinCC Environment" in Industry Online Support under entry ID 88653385:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/88653385)

Note

McAfee Application Control V8.0 does not support Windows Server 2016. Therefore, no
whitelisting protection mechanisms are currently available for Windows Server 2016.

Digital certificates

Take note of entry ID 87057037 for checking digital certificates in your system. Checking of
the certificates is necessary to ensure secure operation of the system and to avoid timeouts.
It also helps in preventing error messages of the digital signature during installation of the Web
Client and the required Web plug-ins.

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/87057037)
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3.4.10

3.4.11

SIMATIC Logon

3.4 Installation of the software, software requirements

Shutting down Windows, standby mode / hibernation

Whenever you shut down Windows on your PCS 7 computers, use the command "Start >
Shutdown Computer" and then select "Shutdown" or "Restart".
The use of "Standby mode" and "Hibernation" has not been released as part of PCS 7.

SIMATIC Logon

The term "SIMATIC Logon Admin Tool" has been replaced by "SIMATIC Logon Role
Management".

Note on the use of smart cards

All smart cards that were formatted with SIMATIC Logon < V1.3 must be formatted again with
a version > V1.3. This is necessary because SIMATIC Logon uses improved encryption for
smart cards as of V1.3. If you attempt to log on with a smart card that is not updated, the
attempt will fail. However, you can always log on with your user name and password via the
keyboard.

Only smart cards with TCOS version 3.0 are supported as of PCS 7 V9.0.

Note

If you have logged on with a chip card and remove this chip card during configuration in the
SIMATIC Logon role management, all the changes that you have not saved up to this point
are discarded.

Reinserting the card will not solve this problem.

Notes on the Windows workgroup

If you require high availability of the user logon, you must operate PCS 7 in a domain
environment, because SIMATIC Logon does not support redundant logon servers in a
Windows workgroup.

Notes on the SIMATIC Logon Event Log Viewer

If you want to print the events in the event log, proceed as follows:
® Click "Export" and export the events in PDF format.
® Print out the exported file.

Instead of the file size of the event log, the number of recorded events corresponding to the
configured filter is displayed.

The filter dialog always shows the date and time based on the settings you have selected for
the date and time in Windows. Display in conformity to ISO 8601 is not possible.
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3.4.12

3.4.13

3.4.14
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Using Microsoft Office

The following Microsoft Office products have been tested for compatibility with PCS 7 V9.0
incl. SP1:

® Microsoft Office Professional 2013 32-Bit SP1 (Excel, Word, Access and PowerPoint)
® Microsoft Office Professional 2016 32-Bit (Excel, Word, Access and PowerPoint)

e Word Viewer 2003 SP3

® Excel Viewer 2007 SP2

e PowerPoint Viewer 2010

On client computers (OS, BATCH, Maintenance, WEB), the Microsoft Office applications Word,
Excel and Access can be used in process mode. This is also the case when the SIMATIC
Management Console is operated on these computers. However, their use may result in
significantly reduced performance in some situations. Microsoft Office must not be used in
process mode on any other operator stations and BATCH stations.

You can find additional information on the compatibility of SIMATIC PCS 7 under entry ID
64847781 in the Industry Online Support:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/64847781)

Ethernet settings

Make sure there are no inconsistencies in Ethernet CPs, switches and network adapters in
terms of their settings/properties for data transmission rate and bus access procedure.

We recommend using the default Autonegotiation setting (procedure for the automatic
negotiation of the best transmission mode between two network interfaces which are directly
connected to one another).

You can find information in the section "How to change the transmission rate and operating
mode in the PC network" of the document "PCS 7 - PCS 7 PC Configuration.pdf' on the
SIMATIC PCS 7 DVD 1/2 in the folder _Manuals\English.

Remote service and remote operation

Use of the Remote Desktop Protocol (RDP) is permitted only for remote maintenance of PCS 7
OS clients. The RealVNC software should be used for remote access to other computers in a
distributed PCS 7 plant (for example, OS servers, engineering stations). Only one remote
session is allowed per PCS 7 station at any given time.
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RDP
Note the following constraints when using RDP:

® No server services (for example, WebNavigator server, DataMonitor server, OPC server)
are permitted to be active on the PCS 7 OS clients. The reason for this lies in the handling
of remote desktop sessions by the Microsoft operating system.

® The existing Windows session must be accepted using the account of the Windows user
logged on locally.

® The remote station cannot be in the Windows logon screen.

VNC

The "RealVNC" Enterprise Edition software has been tested in PCS 7 V9.0 incl. SP1 for
compatibility for remote service access.

You can find the RealVNC edition suitable for your PCS 7 version in the regularly updated
entry ID 64847781 in the Industry Online Support:

® |nternet link (https://support.industry.siemens.com/cs/ww/en/view/64847781)

A\ cauTioN

Access to the operating system level of the local PCS 7 Operator Station (OS) with remote
access

During remote access to an OS via RealVNC, the remote operator has the possibility of

accessing the operating system level of the local OS. The local operator of the OS thus also
has the opportunity - for example via Windows Explorer opened by the remote operator - to
access the operating system level of the local OS at the same time as the remote operator.

You can find more information about the use of "RealVNC" in PCS 7 plants in the Industry
Online Support under entry ID 55422236:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/55422236)

SIMATIC Management Console

Remote access to the SIMATIC Management Console is generally not approved.
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3.4.15 Remote access to OS projects

All users must have been assigned to the "SIMATIC HMI" user group. This also applies to
users who want to open the OS projects remotely. Check in particular the following users:

Users who want to connect a Connectivity Pack Client to a Connectivity Pack Server:
These users must be registered members of the "SIMATIC HMI" group on the Connectivity
Pack Server.

Users accessing the Web center of DataMonitor:

1) If you set up a connection to the OS database, you require an additional Windows user
and password. Assign this user the necessary authorizations for access to the OS
database. For this purpose, set up a separate Windows user on the server and assign this
user to the "SIMATIC HMI Viewer" Windows group.

2) To enable access to a remote computer from the DataMonitor server, the Windows user
and the same password must have been set up on the DataMonitor server and relevant
remote servers. Register this user and the password in the connection administration of
the Web center. For this purpose, proceed as specified under point 1.

Users who want to connect an OPC client with an OpenPCS 7 server:
These users must be registered members of the "SIMATIC HMI" group on the OpenPCS 7
server.

3.4.16 Information about changing faceplate style variants from Classic style to APL style
for SIMATIC Batch or Route Control faceplates

You can only install one of the two style variants (Classic style or APL style) at a time, and
change the style again by running PCS 7 Setup -> Install -> User-defined installation.
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3.5 Licensing

3.5.1 PCS 7 licenses and quantity structures

An overview of the PCS 7 licensing concept and the quantity structures associated with
licensing is available in the document "SIMATIC Process Control System PCS 7; Licenses
and configuration limits".

This document is located on the website for SIMATIC PCS 7 Technical Documentation:

® |nternet link (www.siemens.com/pcs7-documentation)

3.5.2 Managing AS runtime licenses

In order for the licenses to be available in sufficient quantities following the activation of the
license check, we recommend keeping these licenses on the engineering station from where
the controller usually loads them.

Note
Installation of the AS RT PO licenses

Select the appropriate AS RT PO license installation for your engineering environment:

1. AS RT PO license installed on the local engineering PC
Install the AS RT PO license(s) in sufficient numbers on the engineering PC. The favorites
listin the Automation License Manager (see menu "File > Settings") must not contain entries
or the PCs listed do not have AS RT PO licenses.

2. AS RT PO license installed on a license server
Install the AS RT PO license(s) in sufficient number on the license server PC. The favorites
list in the Automation License Manager (see menu "File > Settings") must contain the name
of the license server PC. The local engineering PC must not have an AS RT PO license.
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3.6 Compatibility information

Performing compatibility tests for PCS 7 with various applications

PCS 7 V9.0 incl. SP1 has been tested with the following applications for compatibility:

Application PCS 7 V9.0 incl. SP1

S7 F Systems V6.1 SP2 and V6.2 Upd1
Safety Matrix V6.2 SP1'and V6.2 SP2 Upd2
PLCSIim V5.4 SP8

WinCC C&A V14 SP1 Upd4

Sinema Server

V14 and V13 SP2 (can only be used for Windows
7)

SIMIT V9.1
VMware ESXi V6.5
Trend Micro OfficeScan V12.0
Symantec Endpoint Protection V121
McAfee Endpoint Security V10.2

" Read the additional notes on SIMATIC Safety Matrix V6.2 SP1 in Section 4.18 SIMATIC Safety Matrix

and S7 F Systems.
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411

41.2

41.21

Automation system (AS)

Switching times for H CPU in connection with a fail-safe application

If you load F modules, you must select the monitoring time of each F sub-assembly as longer
than the switching time of the active channel in the H system. Notes on the high limit of this
changeover time can be found in the manual "S7 F-FH Systems - Configuring and
Programming," in Section "A.7".

Run, F-monitoring, and response times:

A table with formulas for calculating the high limit is available under Entry ID 22557362 in the
Industry Online Support:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/22557362)

If you do not follow this instruction, F modules may malfunction when the active channel is
switched.

You can find additional information in the Safety Engineering in SIMATIC S7 system manual
under Entry ID 12490443:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/12490443)

ET 200S

ET 200S diagnostics of load voltage failure

The digital input/output modules of the ET 200S have no diagnostics in the event of load voltage
failure. This means that when the load voltage supply fails on the channel blocks, no "Bad" is
reported. When there is no voltage supply, outputs can no longer be switched via the
application program and the last available value is indicated on inputs.

You can get around this with the following configuration:

e Use DI, DO modules with 24 V DC with power module PM-E DC 24 V:
6ES7 138-4CA00-0AAQ
Because the entire station (IM151 and power modules) is supplied from a common 24 V
DC source, a failure in the voltage supply causes a station failure. This is reported in PCS 7
and causes passivation of all the modules involved, i.e. all channel blocks are set to "Bad".

® Use of DI, DO modules with 120/230 VAC with power module PM-E AC 120/230 V: 6ES7
138-4CB10-0ABO: Applicative monitoring of load voltage in an application program.
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4.1.2.2 ET 200S counter module (article number 6ES7 138-4DA04-0AB0)

When using the counter module in an ET 200S, an interface module >= article number 6ES7
151-1BA01-0ABO must be used.

41.3 ET 200SP

Module Al ENERGY METER ST

You must interconnect and evaluate the data from the process image manually when using
theAl ENERGY METER ST V1.0. Observe the information about reading out measured values
under entry ID 81714201 in Industry Online Support:

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/81714201)

We recommend using and configuring the Al ENERGY METER ST V2.0 module, because the
channel block FbEnMe is available for this module in the PCS 7 Advanced Process Library.
You can upgrade an existing Al ENERGY METER ST V1.0 module to the firmware version
V2.0. You can find the firmware update under the entry ID 98709668 in the Industry Online
Support:

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/98709668)

Read the notes in the manual "PCS 7 Released Modules (V9.0 incl. SP1)".

Value status
The "Value status" functionality for ET 200SP modules is not supported.

414 ET 200pro

The use of ET 200pro with CP 443-5 Extended is only approved with the
6GK7 443-5DX04-0XEO0 module, firmware version V6.4 or later.

The modules from the ET 200pro series must be configured in DPV1 mode in HW Config. In
DPV0 mode, no interrupts are sent to the PCS 7 diagnostic blocks.

41.5 Using S7 PLCSIM

Simple application tests can be carried out with PLCSIM without the availability of AS hardware.

The required adjustments in the PCS 7 project are described in the "How to test with S7-
PLCSIM" section of the "Process Control System PCS 7 Engineering System (V9.0 incl. SP1)"
manual.
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In addition, you must set the "Send/receive raw data block" option to "No" in the connection
settings for AS-OS compilation.

Note

After using PLCSIM, it may be necessary to re-establish the real connection and recompile
the changes made to relevant AS including the real connection to the OS.

OS connections with a simulated WinAC Controller (WinLC RTX or WinAC Slot) are not
possible. See the notes on simulation of a WinAC Controller in the PLCSIM Readme.

4.1.6 Changing the address range of HART modules in ET 200iSP / ET 200M /
ET 200SP leads to address displacements

If HART auxiliary variables are configured retrospectively for HART modules, this leads to an
enlargement of the address field required for these modules. The 1/O field may therefore be
redefined. In doing this, the ability to make configuration changes in RUN is lost. Note that
your project may need to be adapted (symbol tables, CFC charts).

We recommend configuring the modules with a "CiR" address placeholderin the address range
of the HART auxiliary variables during configuration. This ensures that the max. address range
is used and avoids address displacement.

4.1.7 Fast Mode functionality for HART devices

The HART Fast Mode functionality is supported as of configured module version 6ES7 337-?
TF01-0ABO V3.x.

Update 6ES7 33?-?TF01-0ABO firmware to V3.x
Download firmware:

e 331-7TF01-0ABO:
Entry ID 33273268 (https://support.industry.siemens.com/cs/ww/en/view/33273268)

e 332-8TF01-0ABO:
Entry ID 32011516 (https://support.industry.siemens.com/cs/ww/en/view/32011516)

Replace modules 6ES7 33?-?TF00-0ABO with 6ES7 33?-?TF01-0ABO V3.x

® To activate HART-Fast-Mode, you will have to replace the HART module in HW Config
(6ES7 337-?TF00-0ABO with 6ES7 33?-?TF01-0ABO V3.x).

® Then delete the HART field devices and renew the configuration.

® Then activate "HART-Fast-Mode" in the module configuration and "HART RIO SHC Mode"
in the PDM settings.
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Replace modules 6ES7 33?-?TF01-0ABO with 6ES7 33?-?TF01-0AB0O V3.x

® To activate HART-Fast-Mode, you will have to replace the HART module in HW Config
(6ES7 337-?TF01-0ABO with 6ES7 33?-?TF01-0ABO V3.x).

® Then activate "HART-Fast-Mode" in the module configuration and "HART RIO SHC Mode"
in the PDM settings.

Redundant modules

HART-Fast-Mode is not possible for redundantly configured modules.

4.1.8 Configuration in RUN (CiR) with FM 350-1, FM 350-2, FM 355, FM 355-2, CP 341

The modules FM 350-1, FM 350-2, FM355, FM 355-2 and CP 341 are CiR-compatible, which
means that a configuration in RUN can be used so that they can be plugged or pulled via (hot-
swapped) when the AS is in RUN.

Note the following about these modules when configuring in operating mode RUN:

e FM 350-1 and FM 350-2, CP 341:

Changing the module parameters when the CPU is in operating mode RUN resets the
module and is equivalent to restarting the module.

e FM 355 and FM 355-2:
Bumpless channel-specific changes to module parameters when the CPU is in operating
mode RUN are possible to a limited extent; refer to the documentation of the FM modules.

41.9 Isochronous mode in PCS 7

PCS 7 does not support isochronous mode.

4110 Fault-tolerant connections via internal ETHERNET/PROFINET interface

The S7-400 H as of firmware V6.0 supports fault-tolerant connections via your internal
ETHERNET/PROFINET interface.

If you would like to use fault-tolerant AS-AS connections via the internal interface of the V6.0
H-CPU, you need to be aware that the connections to the communication partner can only be
configured via the internal interface of the V6.0 H-CPU or CP 443-1 EX30.

4.1.11 Using PROFINET

Shared Device
The use of PROFINET Shared Device with PCS 7 V9.0 incl. SP1 is temporarily not supported.
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Assigning device numbers

Only device numbers up to 255 are supported by the driver generator in the PROFINET 10
system.

CiR functionality

If you would like to use the CiR functionality on the PROFIBUS master system for S7-400 PN/
DP CPU with firmware <= V6.0.2 (article number 6ES7 414-3EM06-0ABO and article number
6ES7 416-3ES06-0ABO0), you cannot configure PROFIBUS and PROFINET 1/O
simultaneously for the internal interfaces.

Firmware to be used with IM 153-4 PN 10

If you are using the PROFINET module IM 153-4 PN 10 (article number 6ES7
153-4BA00-0ABO0), you need to use a firmware version >=V4.0.1.

You can find information about updating the operating system and downloading the latest
firmware versions in Industry Online Support under entry ID 26331274:

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/26331274)

4.1.12 Using HART auxiliary variables with 4 F-Al HART modules

The configured HART auxiliary variables of the following module are not supported by the PCS
7 channel blocks:

® 4 F-Al HART (article number 6ES7 138-7FA00-0ABO)

You can obtain additional information in the operating instructions "ET 200iSP Distributed /O
Device - Fail-safe Modules" under Entry ID 47357221 in the Industry Online Support:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/47357221)

4113 Using PROFIBUS field devices with IE/PB Link

When using SIMATIC PCS 7 BOX RTX, SIMATIC PCS 7 AS-RTX and SIMATIC PCS 7 AS
mEC RTX you must observe the following:

e parameter assignment of PROFIBUS field devices which are connected to an IE/PB Link
is not possible via Industrial Ethernet connections from the PCS 7 Engineering Station (ES)
or from SIMATIC PCS 7 BOX RTX in single-station operation.

® {0 assign PROFIBUS field device parameters with SIMATIC PDM, connect the ES directly
to PROFINET of the IE/PB Link.
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4.1.14 Compact field unit (CFU)

Note that you must not make any changes in HWConfig to the PA slots (FBO- FB7) for a CFU
station opened in PDM.
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421 Client engineering

4.2 Engineering system (ES)

Opening clients on the ES can sometimes take a very long time, since it involves an implicit
update of all server data (packages) that are not up-to-date. Operator input to the SIMATIC
Manager is not possible during this time.

422 Notes on Configuration in RUN

Changes can be made to the distributed I/O of an S7-400 AS configuration during ongoing
operation; these are described in the following documents:

Method

System configuration

Documentation

CiR
Configuration in Run

Standard automation system
(e.g. AS 410S)

Configuration manual for PCS 7 Engi-
neering System; Modifying the System
during Operation via CiR

H-CiR
Configuration in Run

Fault-tolerant automation system
(e.g. AS 410H)

Fault-tolerant Systems

S7-400H, chapter 17

® |[nternet link (https://
support.industry.siemens.com/cs/
ww/en/view/60458386)

423 CFC/SFC: Download of the automation system (AS)

Programs created with CFC/SFC may only be downloaded with the following functions:

® |n CFC/SFC with menu command "PLC > Download"

® |n SIMATIC Manager (component view), select the project or station and then the menu

command "PLC > Compile and Download Objects"

® |n the SIMATIC Manager (component view), select charts and then the menu command

"PLC > Download".

® in SIMATIC Manager using the menu command "Charts > Selective loading"

Only the loading function of the CFC/SFC guarantees that the engineering data will be
consistent with the PLC data. Downloading changes to the CFC/SFC in the RUN mode of the
S7 CPU is only possible when the download is performed exclusively with these functions.

424 Special characters for the nomenclature

Only certain characters are allowed in names, depending on the language and components.
It is not recommended to use national special characters.
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Special restrictions:

e Acomma"," in tag names (process tags, archive tags etc.) is generally not allowed.

® The project name, picture name, and computer name may not contain multibyte characters
(e.g. Chinese).

For other naming conventions for projects, refer to:
e "Engineering System Configuration Manual”

® WinCC Online Help, using the search term "lllegal characters"

425 Notes on exporting SNMP variables

Access-protected PCS 7 projects

For projects with activated FDA access protection, you must open the OS project in SIMATIC
Manager before exporting the OPC configuration.

You can find additional information about exporting SNMP variables, for example, for the PCS
7 maintenance station, in the function manual "PCS 7 Maintenance
Station".

426 Compiling and downloading S7 connections — downloading to an AS

If connections are to be downloaded to an AS via "PLC > Compile and Download Objects",
the connections of all connection partners are compiled and loaded. Connection partners here
are also all the AS that have a configured connection to the same OS as the AS to be
downloaded. When downloading the connection data to the respective AS, there is a temporary
break in the connection between AS and OS or between the AS with AS-AS communication.

Note
Monitoring times for fault-tolerant S7 connections
When using fault-tolerant S7 connections via TCP/IP, keep in mind that sufficient monitoring

times must be configured. Additional information on this topic is available in your SIMATIC
NET version under Entry ID 15227599 in the Industry Online Support:

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/15227599)
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427 Download

When a "Download" performed from an ES to an OS, the Windows user logged on to the ES
must be known on the target station and a member in one of the following groups there: At
least "User", "SIMATIC HMI" "SIMATIC NET", "SIMATIC BATCH" and required SIMATIC
Route Control "RC_..." groups. In addition, the user also needs full access rights for the folder
into which the project should be downloaded. This includes the sharing and security settings.

428 Notes on cross AS interconnections

® \When using cross AS interconnections, the S7 program names in the multiproject must be
different.

® Hardware requirements:
— S7-400 CPU with firmware version >= V3.1
— Communications processor >= 443-1EX10 V2.1.
- PCS 7 AS RTX and PCS 7 AS mEC RTX

® The compact stations BOX RTX and BOX 416 cannot be used for AS-wide
interconnections. Use the communication blocks of the PCS 7 Advanced Process Library
for AS-AS communication.

e |f there is an overload on the S7-400 CPU or if there are network disruptions, the following
messages can appear: "Overload sender: S7 connection ID xxxx". This means that a data
transfer cycle could not be executed. The data will be transferred in the next cycle.

429 F-monitoring time of F modules and F field devices after Y Link/DP-PA Link

By extending the calculation of the monitoring times for updating the reserve, it is possible as
of PCS 7 V7.1 SP1 to consider F-monitoring times of F modules and F field devices after Y
Link/DP-PA Link.

Note

When you activate the option "Calculate F modules after Y Link" you will change the CRC for
the F module configuration. You will have to compile the F program once again.

You may have to adjust the F monitoring times of the affected F modules and F field devices
prior to the calculation.

Use the Excel file "s7ftime" to determine the F monitoring times for F modules after Y Link and
F field devices on PROFIBUS-PA.

SIMATIC S7 F systems: execution times of fail-safe blocks, runtime of F shutdown group,
monitoring and reaction times.

Entry ID 22557362:
e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/22557362)
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4.2.10

4.2.11

4.2.12

4213

Configuration of fail-safe modules in ET 200M PROFINET stations

In order to operate fail-safe applications on PROFINET, the following requirements must be
met:

® All configured devices and the employed F-drivers must support PROFIsafe V2 mode
® The S7 F Configuration Pack version used must be V5.5 SP12
Note the following before the first compilation of the hardware configuration:

® For fail-safe operation on PROFINET, be sure to use only fail-safe modules that are listed
in the "PCS 7 V9.0 incl. SP1" module filter under PROFINET 10 -> I/O -> ET 200M.

® Be sure to use a version >= V1.3 of the F-system library in your project. If you have not yet
used F-blocks in your project, place at least one F-block from the F-library version >= V1.3
within a CFC (for example, F-channel drivers).

Merging projects after distributed editing (multiproject engineering)

If you merge projects into a multiproject, you have to execute the following menu command:
"File > Save as... > With Reorganization (slow)".

Note on upgrading process objects of a CPU 410-5H system expansion card

During the upgrade of the process objects of a CPU 410-5H system expansion card (SEC),
only one instance of the Automation License Manager (ALM) may be active.

Notes on AS-OS compilation

Using named connections

4.2.14

50

Within the context of PCS 7, we recommend using "named connections" for the AS-OS
connection.

If you are using a connection type other than "named connections", you take note of the "Send/
receive raw data block" option in the connection settings during AS-OS compilation. You should
set this option to "No" if it is not needed for special applications.

Notes on updating block contacts at SFC types

There is a possibility that changes which have not been applied yet, which means updates of
block contacts at SFC types, are present in existing projects. Therefore, check your project (if
you are using SFC types with block contacts) to see if any such changes have been made.

To do this, select the menu command "Options > Block contacts" in the SFC Editor while the
SFC type is open.
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If there are still block contacts that still have to be updated, select them and click "Update".

Note

After these updates, the respective SFC instances must be stopped for downloading.

Refer to the entry ID 109751583 in the Industry Online Support for instructions on how to
handle updates of block contacts at SFC types that have not been adopted:

e [nternet link (https://support.industry.siemens.com/cs/document/109751583)
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4.3 PCS 7 libraries
4.3.1 Diagnostic alarms for digital input modules SM 321-7BH00 and SM 321-7BHO01

Diagnostic evaluation for channel-based diagnostic interrupts of the module

When using digital input modules SM 321-7BH00 and SM 321-7BHO01, the diagnostic
evaluation for a channel-based diagnostic interrupt is performed in channel groups.

When using digital input module SM 321-7BHO1 HF, the channel-related diagnostic interrupt
takes place for each individual channel.

Diagnostic option: Missing encoder supply
SM 321-7BHO00 and SM 321-7BH01
e Digital input channels 0 to 7 are combined into channel group 0.
e Digital input channels 8 to 15 are combined into channel group 1.
Eight alarms are output for each channel group if the encoder supply is missing.
e "Error channel 00" .... "Error channel 07" or

® "Error channel 08" .... "Error channel 15"

Diagnostic option: Wire break
For SM 321-7BHO1 only
e Digital input channels 0 and 1 are combined into channel group O.

e Digital input channels 2 and 3 are combined into channel group 1.

e Digital input channels 12 and 13 are combined into channel group 6.
e Digital input channels 14 and 15 are combined into channel group 7.

The channel involved can therefore not be clearly identified in the text of the diagnostic interrupt/
diagnostic message.

4.3.2 Faceplate Designer

Creation and modification of user-specific faceplates

The creation and modification of user-specific faceplates using the "Faceplate Designer" is no
longer supported as of version V9.0.
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4.3.3 Updating the PCS 7 Basic Library and the Advanced Process Library

The libraries PCS 7 Basis Library and PCS 7 Advanced Process Library as of V9.0.1.2 contain
improvements for upgrading via TCiR, which is why you should update before upgrading to
these versions.
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4.4 Operator station (OS)

441 OS-specific information and notes on installation and use

You will find PCS 7 OS-specific information and notes on installation and use of this component
in the readme file of the product.

442 Customized user programs

If you create your own applications, system tests in the relevant environment are necessary
to ensure the stability of the entire system.

443 Starting process mode on the OS server

® Process mode will not be started on an OS server if this server is not connected to the
network.

® When you start process mode on a redundant server, make sure that the first server takes
over process mode completely before the redundant partner is started. No client should be
active before process mode is started on a server for the first time. The OS clients can then
be activated.

444 Deactivating a redundant OS server

Before deactivating a redundant server, ensure that the partner server is in an state that is
fault-free and operational (for example, there are no process coupling faults). Archive
synchronization must be competed before deactivation, which can be recognized with the
corresponding process control message.

445 OS change download

Procedure for extensive changes

If an AS has been added, a redundancy switchover and entries in the message system may
occur when changes are download. The following procedure is recommended when extensive
changes are involved: Configure the changes in single steps ("packet-by-packet") on the ES
and then transfer them to the OS in individual "packets".
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Changes to tags with access to an OPC-DA-Client application

It may happen in the course of configuration that tags are deleted from a project that are
requested at this time by an OPC-DA-Client application using a Subscription . Restoration of
these tags in the project will not automatically initiate an update of the tags by means of OPC.
Provided the tags in question are available in an OS server project and the OPC DA server is
running on an OS client or OpenPCS 7 station, it is sufficient to initiate a redundancy switchover
of the corresponding OS server project to trigger an update of the tags. Otherwise, the OPC-
DA-Client application needs to re-register the tags in question.

446 Setting access permissions in the operating system

A PCS 7 OS automatically sets the "SIMATIC HMI" local user group following installation under
Windows. The currently logged on user and local administrator are registered in this user
group. Enter the users who should have access to PCS 7 OS in the "SIMATIC HMI" group
with their logon information.

You can find more detailed information in:

® The WinCC Information System under "Installation Notes > Installation Requirements >
Access Permissions in the Operating System"

® The document "PCS 7 - PC Configuration.pdf” on the SIMATIC PCS 7 DVD 1/2 in the
folder _Manuals\English

® The PCS 7 Compendium Part F - Industrial Security. Internet link (https://
support.industry.siemens.com/cs/ww/en/view/109756871)

All Window users who work with PCS 7-, PCS 7 OS or Route Control projects must also be
members of the "SIMATIC NET" group.

447 Controls

Using controls from third-party suppliers may lead to errors such as performance problems or
system blockage. The user of the software must assume responsibility if problems are caused
by third-party controls. We highly recommend that you run a system test to ensure safe
operation before putting them into use.

448 User interface and design
In PCS 7, make the following setting for the appearance of the user interface in process mode:
® Design "WinCC 3D"
All other WinCC designs are not supported by PCS 7.
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449

4410

4.4.11

4412
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Note the following:
® Make sure that the design is set in a uniform manner for all the projects of a plant.

e |f you change the setting of the design, check the visualization of self-generated objects
and adapt these if necessary.

e Retain the setting if you update the software. During a software update, changing the setting
for the appearance of the user interface in process mode could cause considerable
changes.

Disabling / enabling messages using the WinCC Alarmcontrol

The disabling / enabling messages functionality using WinCC Alarmcontrol has not been
approved for PCS 7.

Language setting for C scripts

Note that WinCC now supports Unicode. To ensure your C scripts run without problems, you
need to make sure that the language set in the Global Script C editor is correct. If you select
"Dynamic: Project setting", scripts run in the language that was set globally for the project. You
can make this global project setting under "C scripts with language setting "Dynamic" in
Runtime" in the "Options" tab, which is located in the "Project properties" dialog of the WinCC
Explorer. The "Operating system language for non-Unicode programs" option is preset and
recommended as the global project setting for PCS 7. You can find additional information in
the WinCC documentation (WinCC Information System) and the WinCC readme.

Consistency between the plant hierarchy and the Picture Tree Manager for SFC
visualization

To prevent delays during the start of OS Runtime and during SFC operation on the OS client,
you need to ensure the following:

e all areas of the plant hierarchy (PH) that contain SFC charts must also be created by name
in the WinCC Picture Tree Manager.

OS areas which should not be available for selection in WinCC Runtime can be configured as
invisible via the OS project editor.

Prevent operating system access through key combinations

With the option "Disable shortcut keys for operating system access" in the properties of the
PCS 7 OS computer, the key combinations for ease of access are also disabled.

To prevent access to the operating system via key combinations for activating high contrast
when using Windows 7 SP1 (64-bit), you need to install the Microsoft patch KB2516889:

e [nternet link (https://support.microsoft.com/kb/2516889)
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4413 Setting the Windows taskbar for multi-monitor cards

In multi-monitor mode, the same zoom level must be configured for all monitors in the operating

system. The Windows taskbar may only be displayed on the primary monitor and may not be
extended to other monitors.

4414 WinCC Servicemode

The WinCC service mode is released in connection with PCS 7 OS for the following
configurations:

® PCS 7 OS Server
e PCS 7 Maintenance Station
® PCS 7 OS Server combined with PCS 7 Maintenance Station

4.4.15 PCS 7 Process Tag Browser

In the PCS 7 Process Tag Browser, only such process tags are listed which are assigned to
the image hierarchy of the OS project.
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4.5 SIMATIC BATCH
45.1 Compiling and loading BATCH with the "Compile and Download Objects" function

Note that when you modifying projects, compiling and loading should always be performed in
the following sequence: AS, OS, BATCH.

4.5.2 Access permissions
The following sharing is set for SIMATIC BATCH during the installation:
e BATCH

The PCS 7 software manages the share permissions automatically.
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4.6 SIMATIC Route Control

4.6.1 Loading the SIMATIC Route Control server in conjunction with SIMATIC NET
Softnet IE-RNA

If the "Unknown" status continues to be displayed after loading the SIMATIC Route Control
server from the ES of the SIMATIC RC SERVERDIALOG, you need to do the following:

® Open the Microsoft Management Console for services using Start > Run: Enter
"services.msc"

® Change the start type from "Automatic" to "Automatic (delayed start)" for the following
services:

— SCSMonitor
— SIMATIC Route Control Server

® Reboot the computer.
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4.7 SIMATIC PDM
4.71 Using the Device Integration Manager

Once you have installed SIMATIC PDM, you must import the devices you are using onto your
computer. Run the "Device Integration Manager" program for this.

After an update installation to PCS 7 V9.0 incl. SP1, you must re-import the "Device Library"
device catalog.

The devices supported by PDM are included on the supplied "Device Library". You can
download the latest version from the Support area of the SIMATIC PDM website.

® |nternet link (https://www.siemens.com/simatic-pdm)

4.7.2 Canceling the module redundancy for HART modules of ET 200M remote 10s

In order to cancel the module redundancy set in the hardware configuration (HWC), you need
to adhere to the following procedure:

1. Delete the module in question and then compile the hardware project
2. Remove the deleted module from the process device plant view or network view
3. Configure the module again in HWC

This ensures that the redundancy is removed correctly.

4.7.3 Note on project migration

60

When migrating a PDM project from a previous version, it is absolutely necessary to do the
following:

e |nstall all add-on packages used in the project before you open the project for the first time.
® Projects are migrated automatically when you first open them.

You can find additional important information in the SIMATIC PDM readme in the section
"Migrating Projects".
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4.8 Process Historian (PH)

Commissioning the PH
If you want to integrate the PH or a redundant PH partner into your system for the first time or
perform a software update, you need to consider the following:
The PH only starts to reference data from the OS servers and batch servers if it is activated
before they are. You therefore may need to restart the OS server or batch server to create this
sequence of events.
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4.9 Information Server (IS)

Installation of IS 2014 SP3

Read the instructions in "InstallNotesINFSVenUS.pdf" for the installation of IS 2014 SP3. You
will find the file on the SIMATIC PCS 7 DVD 1/2 in the folder "27b_PH+IS_Install_and_Release-
Notes".

Installation of SIMATIC IS - BATCH Options

The installed version of the IS BATCH Options must match the version of the SIMATIC BATCH
Server .

Update from IS 2013 to IS 2014 SP3

When upgrading from IS 2013 to IS 2014 SP3, note that some settings and templates must
be recreated under certain circumstances.

1. Always recreate:

E-mail settings

Dashboards

Connections to WinCC data sources

Subscriptions that were created with a WinCC data source

Reports that were created with a WinCC data source

2. If created by a user other than the one who performed the upgrade, recreate:
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Private templates
Private subscriptions

Private reports
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Note

If the message "Input string was not in a correct format" appears after the migration when you
call a report template from the IS interface, check your data source in the Microsoft Report
Manager.

Follow the steps below:
® Open an Internet browser on the IS computer.

e Copy the following link to the address bar. If necessary, adapt the protocol, port and
instance name (Reports_WINCC or Reports_INFSERVER instead of
Reports_HISTORIAN) to your configuration:
http://localhost/Reports_HISTORIAN/Pages/DataSource.aspx?ltemPath=
%2fDatasources%2flInfoServer&ViewMode=Detail

® In the editing field of the connection string, change the value of the "Initial Catalog" from
"Master" to "Webframe":

"Initial Catalog=Webframe;"
Leave the other parameters unchanged and save the change by pressing "Apply".
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4.10 PCS 7 Web options

4.10 PCS 7 Web options

PCS 7 Web server

Information about the PCS 7 Web add-on package is available in the "PCS 7 Web Option for
0OS" manual. This document is located on the website for SIMATIC PCS 7 Technical
Documentation:

® [nternet link (www.siemens.com/pcs7-documentation)

WinCC/WebUX

As of WinCC/WebUX V7.4, process pictures from PCS 7 projects are also supported. The
same restrictions as for process pictures from WinCC projects apply.
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4.11 DataMonitor (DM)

4.11 DataMonitor (DM)

Operating and monitoring via the Web

The "Process Screen" function is no longer used for operator control and monitoring via the
Web in DataMonitor. Instead, the "WinCCViewerRT" Web viewer can be used on the
DataMonitor client.

For more information, please see the "DataMonitor Release Notes".

Restrictions on usage of the DataMonitor server

Always use the DataMonitor server on a computer that is not operated in WinCC ServiceMode.
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4.12 OpenPCS 7

4.12 OpenPCS 7

Evaluation of "Active Time"

"Active Time" cannot be used for evaluations with Historical Alarm&Event.

Project languages

If you have project languages other than Western European Languages (code page Windows
—1252), an OPC A&E Client may only use the languages “German” or “English”, as offered
by the OpenPCS 7 OPC server.

Changes to tags with access to an OPC-DA-Client application
Observe the section OS change download (Page 54).

Downloading the OpenPCS 7 station

Following installation or update of OpenPCS 7, you need to perform a "Download" of the
OpenPCS 7 station on the engineering station.
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4.13 Redundant systems

413 Redundant systems

PCS 7 as of V7.1 SP2 contains advanced self-diagnostics for redundant software systems
(servers). If this diagnostics routine detects an internal fault, if the redundant partner server is
fully functioning, all communication connections on the server affected by the fault are
disconnected (terminal and system bus).

Example:
® WinCC and BATCH Server are running on server (A) .

® The full function of the redundant partner server (B) is achieved when WinCC and BATCH
Server are running on server (B) and the runtime data of WinCC and BATCH are
synchronized.

Automatic restart of the affected server is only performed when this full functionality is achieved.

Requirements

® Use of a PCS 7 OS (multi-station) redundant system, SIMATIC BATCH or SIMATIC Route
Control.

® You must make the following configuration settings on the server systems:
— Automatic Windows logon (not relevant for servers in WinCC service mode)
— Automatic start of the PCS 7 server applications

® Disable the group policy "Display event logging for shutdown"
Procedure:

— Use [Windows button]+[R] to launch the "gpedit.msc" file and open the following path
in the group policies editor:
Computer Configuration > Administrative Templates > System

— Disable the group policy "Display event logging for shutdown"

® Before a PCS 7 server application is exited, an availability check is carried out on the
relevant redundant partner server. The aspect of the data synchronization is not taken into
account in the availability check.
If the partner server is not fully functional, the user is informed of this status and can proceed
accordingly.
The availability check is only carried out in service mode if a user is logged on.

Activation of automatic logon in Microsoft Windows

You can find a description of the options for activating automatic logon in Microsoft Windows
under entry ID 23598260 in the Industry Online Support:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/23598260)

Additional information

You can find additional information in the corresponding application descriptions (manual and
readme for PCS 7 OS, SIMATIC BATCH, SIMATIC Route Control, SIMATIC NET).
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4.14 SIMATIC NET

4.14 SIMATIC NET

S7-RedConnect based on TCP/IP

Be aware of the following restrictions when using S7-RedConnect based on TCP/IP:

e CP 1613 (A1 and A2) is not supported

VLAN architectures for PCS 7

You can find information about configurations with virtual LANs (VLAN) available with PCS 7
in the Industry Online Support under Entry ID 66807297:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/66807297)

Using SIMATIC NET Softnet IE-RNA in connection with WinCC secure communication

If you use secure communication between PC stations, we recommend that you use the
"Automation Firewall" released for PCS 7 as a back firewall for communication across the plant.

You can find additional information in section "Setting package size for communication (MTU
size)" of the PCS 7 manual "PCS 7 - PCS 7 PC Configuration.pdf".

Internet link (https://support.industry.siemens.com/cs/ww/en/view/109754983)
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4.15 SIMATIC Management Console

4.15 SIMATIC Management Console

Using whitelisting with McAfee Application Control

The following functions of the SIMATIC Management Console are not available using active
whitelisting with McAfee Application Control:

® Creating setup package

e Starting computer-specific installation
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4. 16 Maintenance Station

4.16 Maintenance Station

Note regarding "Call configuration data" function in the diagnostic screens of the maintenance station

A warning notice is displayed when a website is called with the "Call configuration data" icon
whose HTTPS certificate cannot be checked.

Result:

The operator can use this warning notice to gain access to the operating system level of the
local PCS 7 Operator Station (OS) despite enabled keylock.

Remedy:

® Enter all necessary certificates in the list of trusted certificates of the Internet Explorer for
all PCS 7 operator stations which display diagnostic screens of the maintenance station.

Recommendation:

® To increase security, we recommend replacing the default certificates with appropriate
certificates for all web servers.
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4.17 SIMATIC IPC DiagMonitor

417 SIMATIC IPC DiagMonitor
DiagMonitor V5.0+SP2+Upd1 has been tested with PCS 7 V9.0 incl. SP1 for compatibility.

If a version of DiagMonitor < V5.0 is already installed on the system, take note of the following
for installation of DiagMonitor V5.0+SP2+Upd1 :

® Remove the installed version of DiagMonitor under Windows Control Panel > Programs
and Features.

® Reboot the computer once the program has been uninstalled.

Run the following files one after the other on the SIMATIC PCS 7 V9.0 incl. SP1 DVD 2/2 under
Additional_Products > DiagMonitor_V5.0+SP2+Upd1 to perform the installation:

® DiagMonitor_Silent_Install.bat
® CM_Activate.exe

You can find additional information on the installation and the approved types of computers in
the document "GettingStarted.pdf” in the installation folder.
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4.18 SIMATIC Safety Matrix and S7 F Systems

4.18 SIMATIC Safety Matrix and S7 F Systems
SIMATIC S7 F Systems

SIMATIC S7 F Systems V6.1 SP2 and V6.2 Upd 1 have been tested with PCS 7 V9.0 incl.
SP1 for compatibility.

You can find additional up-to-date information on SIMATIC S7 F Systems in the Industry Online
Support at:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/ps/14363)

See section "4.3 Conversion to S7 F Systems V6.2" in the "SIMATIC Industrial Software S7 F/
FH System; Configuring and Programming" manual.

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/109742100)

For SIMATIC S7 F Systems use SIMATIC S7 F ConfigurationPack V5.5 SP13. This forms part
of the setup package S7 F Systems V6.2 Upd1.

For additional information please refer to the Entry ID 15208817in the Industry Online Support:

e [nternet link (https://support.industry.siemens.com/cs/ww/en/view/15208817)

Released operating systems when using PCS 7 with SIMATIC S7 F Systems

Installation DVD Windows 7 Windows 7 Windows 10 Windows Windows
SIMATIC S7 F Sys- Professional | Ultimate / En- | Enterprise Server Server
tems SP1 terprise SP1 | 2015 LTSB 2012 R2 2016
64-Bit 64-Bit 64-Bit Standard Edi- | Standard Edi-
(only English) tion tion
64-Bit 64-Bit
Engineering Station | V6.1 SP2 X X - - -
V6.2 Upd1 X X X X X
Operator station V6.2 Upd1 X X X X X
Legend for the table:
"-" = incompatible
"X" = compatible
Footnotes:
" Only in the version "Windows Server 2012 R2 Standard with Update" or with KB 2919355 ,Windows Server 2012 R2
Update*®
SIMATIC Safety Matrix

SIMATIC Safety Matrix V6.2 SP1 and V6.2 SP2 Upd2 have been tested with PCS 7 V9.0 incl.
SP1 for compatibility.

You can find additional up-to-date information on SIMATIC Safety Matrix in the Industry Online
Support at:

e |nternet link (https://support.industry.siemens.com/cs/ww/en/ps/14364)
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4.18 SIMATIC Safety Matrix and S7 F Systems

Note on the use of von SIMATIC Safety Matrixin conjunction with SIMATIC Safety Matrix AS-OS-

Engineering

Released operating systems when using PCS 7 with SIMATIC Safety Matrix

The installation of SIMATIC Safety Matrix AS-OS-Engineering V6.2 SP3 Upd1 is required for
the use of SIMATIC Safety Matrix in conjunction with SIMATIC Safety Matrix AS-OS-

Engineering.

When using SIMATIC Safety Matrix V6.2 SP2 Upd2 , SIMATIC Safety Matrix AS-OS
Engineering V6.2 SP3 Upd1 is already included.

For installation of SIMATIC Safety Matrix AS-OS-Engineering V6.2 SP3 Upd1 use the
enclosed data storage medium "SIMATIC Safety Matrix V6.2 SP2 Upd2".

Start the setup and select the "Engineering" option. When using SIMATIC Safety Matrix V6.2
SP1, you must deselect "Safety Matrix Engineering Tool V6.2 SP2".

You can also find additional information under entry ID 109745595 in Industry Online Support:

e |nternet link (https://support.industry.siemens.com/cs/ww/en/view/109745595)

Installation DVD Windows 7 Windows 7 Windows 10 Windows Windows
Safety Matrix Professional | Ultimate / En- | Enterprise Server Server
SP1 terprise SP1 2015 LTSB 2012 R2 2016
64-Bit 64-Bit 64-Bit Standard Edi- | Standard Edi-
(only English) tion tion
64-Bit ' 64-Bit
Engineering Station | V6.2 SP1 X X - - -
V6.2 SP2 Upd2 X X X X X
Operator station V6.2 SP2 Upd2 X X X X X

Legend for the table:
"-" = incompatible
"X" = compatible
Footnotes:

" Onlyinthe version"
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4. 19 Nofes on the documentation

4.19 Notes on the documentation

PUD Manager links to the Service & Support Portal for Windows Server 2012 R2 and Windows Server
2016

For security reasons, PUD Manager links to the Service & Support Portal (SIOS) do not work
with Windows Server 2012 R2 or Windows Server 2016.
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SIMATIC PCS 7 DVD
SW components

PCS 7 V9.0

PCS 7 V9.0 incl. SP1

_Product Information

Automation License Manager

V5.3 + SP4 + Upd1

V5.3 + SP4 + Upd2

STEP 7 Basis V5.6 V5.6 + Upd3

CFC V9.0 V9.0 + SP1
S7-SCL V5.6 V5.6

SFC V9.0 V9.0 + SP1

TH V9.0 V9.0 + SP1
IEA-PO V9.0 V9.0 + SP1

PCS 7 Basis Library V9.0 V9.0 + SP1

PCS 7 Advanced Process Library V9.0 V9.0 + SP1

PCS 7 MPC V8.1 V8.1

Logic Matrix FunktionBlocks V9.0 V9.0 + SP1

Logic Matrix Editor V9.0 V9.0 + SP1
VersionCrossManager V9.0 V9.0 + SP1
Version Trail V9.0 V9.0 + SP1

PCS 7 PID Tuner V8.0 + SP1 + Upd2 V8.0 + SP1 + Upd2
DOCPRO V9.0 V9.0 + SP1
PLCSIM V5.4 + SP8 V5.4 + SP8
SIMATIC WinCC V7.4 + SP1 + Upd1 V7.4 + SP1 + Upd4
WebNavigator V7.4 + SP1 + Upd1 V7.4 + SP1 + Upd4

DataMonitor

V7.4 + SP1 + Upd1

V7.4 + SP1 + Upd4

Process Historian

Version 2014 SP2 + Upd3

Version 2014 SP3

Information Server

Version 2014 SP2 + Upd3

Version 2014 SP3

OpenPCS 7 V9.0 V9.0 + Upd1
SFC Visualization V9.0 V9.0 + SP1
AS-0S-Engineering V9.0 V9.0 + SP1
PV Insinfo Server V9.0 V9.0 + SP1
PCS 7 Basis Faceplates V9.0 V9.0 + SP1
PCS 7 Advanced Faceplates V9.0 V9.0 + SP1
Logic Matrix Faceplates V9.0 V9.0 + SP1
SIMATIC NET PC-Software V14 + SP1 V14 + SP1 + Upd2
SIMATIC NET SOFTNET-IE RNA V14 V14
SIMATIC Management Console V9.0 V9.0 + Upd1
SIMATIC Management Agent V9.0 V9.0 + Upd1
SIMATIC PUD Manager V1.1 V1.1 + Upd1
SIMATIC BATCH V9.0 V9.0 + SP1

PCS 7 Readme V9.0 including SP1 (online)
Readme, V9.0 SP1, A5E42605758-AC

75



Software components in SIMATIC PCS 7 V9.0 incl. SP1

SIMATIC PCS 7 DVD PCS 7 V9.0 PCS 7 V9.0 incl. SP1
SW components

SIMATIC Logon V1.6 V1.6

SIMATIC PDM V9.1 V9.1 + Upd2

SIMATIC PDM Devices

Internet download

Internet download (https://
www.siemens.com/simatic-

pdm)

SIMATIC Route Control V9.0 V9.0 + Upd1
PCS 7 System Documentation V9.0 V9.0 + SP1
PCS 7 Tools V9.0 V9.0 + SP1
SQL Server 2014 SP2 2014 SP2
WinCC_Options : DVD 2/2 DVD 2/2

WinCC_WebNavigator

V7.4 + SP1 + Upd1

V7.4 + SP1 + Upd4

Additional_Products : DVD 2/2 DVD 2/2

(manual installation required)

Crystal Reports for Route Control V11.0 V11.0

DiagMonitor V5.0 + SP2 V5.0 + SP2 + Upd1

Information Server BATCH Options

V8.0 + SP1 + Upd19
V8.1 + SP1 + Upd12

V8.0 + SP1 + Upd20
V8.1 + SP1 + Upd14

V8.2 + Upd6 V8.2 + Upd7
MTU V1.0 V1.0
Report Builder V3.0 V3.0
S7 Block Privacy V1.0 + SP4 V1.0 + SP4
SIMATIC Assessment Suite - Data Collector SAS-DC_2016_1 SAS-DC_2017_1
SIMATIC Management Agent V9.0 V9.0 + Upd1
SIMATIC Management Console V9.0 V9.0 + SP1
InventoryDataProfile
Sonstiges :
PKZIP V14.4 V14.4
DotNetFramework V4.6.2 V4.6.2
S7 F Systems Vv6.2! V6.2 + Upd1?

SIMATIC Safety Matrix

V6.2 + SP2 + Upd1"

V6.2 + SP2 + Upd2!

" Delivery on separate data storage medium

PCS 7 Readme V9.0 including SP1 (online)
76 Readme, V9.0 SP1, A5E42605758-AC


https://www.siemens.com/simatic-pdm
https://www.siemens.com/simatic-pdm
https://www.siemens.com/simatic-pdm

Change history PCS 7 Readme (online)

Changes since delivery release PCS 7 V9.0 incl. SP1

Version Edition Change
2017-12-18 (ONLINE) 12/2017 | Delivery version PCS 7 V9.0 incl. SP1
2018-07-30 (ONLINE) 07/2018 Section 3.4.1.1 - Requirements
® Note on the cumulative Windows 10 Update extended
2018-07-30 (ONLINE) 07/2018 Section 3.4.1.2 - Notes on installing the software
® |nstallation of the SIMATIC Management Agent extended
2018-07-30 (ONLINE) 07/2018 Section 4.1.14 - Compact Field Unit (CFU)
® New section added
2018-07-30 (ONLINE) 07/2018 | Section 4.3.3 - Updating the PCS 7 Basic Library and the Advanced Process Library
® New section added
2018-07-30 (ONLINE) 07/2018 | Section 4.4.14 - PCS 7 Process Tag Browser
® New section added
2018-09-24 (Online) 09/2018 | Section 3.3.2—AS hardware
e Time synchronization with BURK MOBATIME GmbH time servers
2018-09-24 (Online) 09/2018 | Section 4.4.13—Setting the Windows taskbar for multi-monitor cards
® New section added
2018-09-24 (Online) 09/2018 Section 4.19—Notes on the documentation

® Text amended to PUD Manager
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